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3. Click the Edit button, or double-click the item. The following window appears: 

 
4. Edit the menu name if desired. 

5. Type in part of the menu item name in the Filter box, to refine the list of menu Procedure items. 

6. Select the required menu procedure. 
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7. Drag the required menu procedure from the right hand side (from point 3) onto the desired place 
in the menu structure on the left hand side. A popup box will appear to allow the menu name to be 
edited: 

 
8. Enter any optional parameters. For example, when adding a Clarity report, the name of the report 

to run must be specified in the parameters. 

9. A shortcut key combination and icon can be assigned. Any menu function that is assigned a 
shortcut will also appear in the shortcut menu (see page 77) for the module whose menu is being 
edited. 

Note: EXO Business does not enforce uniqueness on shortcut key combinations - you must ensure 
that you do not assign the same key combination to multiple functions in the same menu. 

10. Move the selected menu item up and down the list as required by using the Move Up and Move 
Down buttons or by pressing CTRL+UP ARROW and CTRL+DOWN ARROW. You can also right-click on 
menu items to reposition, delete or edit them. 

Notes 

• If menu items are changed on the current user’s menu, after saving and closing the menu editor, 
select File > Refresh Settings from the main EXO Business menu to refresh the user’s menu. 
(Refresh Settings also refreshes other setup options, such as user profile settings). 

• Whole menus can be exported and imported between databases using the relevant toolbar 
buttons. 

• The menu procedure “External Program” allows other applications to be launched from the MYOB 
EXO Business menu. 

• Separator bars can be added to give separators on the menu, and the separator bars can be 
renamed to form sub-menu headings. 

• The menu procedure “Run Clarity Report” is used to run a report designed in the Clarity report 
writer. The report name is entered in the parameter box, e.g. SPECIALREPORT.CLR. 
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Configuring Shortcut Menus 

The main window of each module includes a shortcut menu in the title bar: 

 
This menu can be configured to give quick access to commonly used functions. Either click on the icon for 
the function you want, or use the shortcut key combination that has been assigned to that function. 

Note: Hovering the mouse pointer over an icon in the shortcut menu shows you the name of the 
function and the shortcut key combination assigned to it. 

Shortcut menus for each module are set up when configuring dropdown menus (see page 75). 

To add a function to a shortcut menu: 

1. Open the Dropdown Menu Designer (see page 75). 

2. If the function you want to add to the shortcut bar has already been added to the window, double 
click on it. If it has not yet been added, add it by dragging the function onto the menu from the 
Procedures list on the right. In either case, the Menu Item window opens: 

 
3. Select a ShortCut key combination and an Icon. 

Note: EXO Business does not enforce uniqueness on shortcut key combinations - you must ensure 
that you do not assign the same key combination to multiple functions in the same menu. 

4. Click OK, then save changes to the menu. 

The function now appears in the shortcut bar, using the icon you specified. 

Note: If the module whose shortcut bar you are configuring is already open, you will need to select 
Refresh Settings from the File menu to update the shortcut bar. 
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Configuring Business Flow Menus 

Business Flow Menus are added and edited in the Configuration Assistant at Staff > Menus > Business Flow 
Menu. 

Tip: Default menus can be copied with the Copy Menu button and used as the basis of a new menu. 

To add a new Business Flow Menu: 

1. Select the module whose menu you want to edit from the Program box, then click New to create a 
new menu. The Business Flow Menu editing screen appears: 

  

The left-hand pane is the designer area where the menu is created. The right-hand pane contains a 
toolbox of menu elements and a list of all available menu procedures. A floating Menu Designer 
Component Browser window lets you configure the properties of the currently selected item and 
its “child” component items. The Component Browser also displays the name of the menu item 
that the mouse is current over. 

2. In the Menu Name field, enter a new name for the menu, which will be referred to when assigning 
the menu to users. 

3. Click on the WorkSpace item on the Menu Designer Toolbox, then click on the design area on place 
it. 

4. To change the size of the WorkSpace, hover the mouse over it and hold down CTRL. While CTRL is 
held down, moving the mouse resizes the WorkSpace. Alternatively, double-click on the WorkSpace 
to view its Properties dialog and enter Width and Height values. 

5. To position the WorkSpace, hover the mouse over it and hold down SHIFT. While SHIFT is held 
down, moving the mouse resizes the WorkSpace. Alternatively, double-click on the WorkSpace to 
view its Properties dialog and enter Top and Left values. 

Tip: To make the WorkSpace resizable, double-click on it and set the Custom property to “R” and 
the Align property to “Client”. 
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The WorkSpace forms the base of the Business Flow menu, defining its size and shape. All other menu 
items are placed on it. 

Tip: You can place Panel items on the WorkSpace, then place other items on the panel. This allows 
you to position multiple items at once. 

To add a text link to a Business Flow Menu: 

1. Enter text into in the Filter field to filter the list of available procedures. 

2. Drag a procedure from the list to the WorkSpace. A window displaying the link’s parameters 
appears: 

3. Enter any parameters that may be required, then click OK. 

Tip: You can add links to an external file or executable by dragging the “External Program” procedure 
onto the WorkSpace, then changing its Name and entering the filename of the file/executable into its 
Parameters field. Similarly, you can add a link to a Clarity report by dragging the “Run Clarity Report” 
procedure onto the WorkSpace, then specifying the report. 

To add a button to a Business Flow Menu: 

1. Click on the Buttons item on the Menu Designer Toolbox. 

2. Select the style of button (Standard, Focus or Transparent), then click anywhere on the WorkSpace 
to place it. 

Note: Transparent buttons allow more than one image to be specified. These images correspond to 
the various states of the button, e.g. inactive, active, hover. 

3. Enter any parameters that may be required, then click OK. 

4. Size and position the button using the CTRL and SHIFT keys. 

5. Enter some text into in the Filter field to filter the list of available procedures. 

6. Drag a procedure from the list onto the button. This is the procedure that will be activated when 
the button is clicked. 

7. Enter any parameters that may be required, then click OK. 

Tip: You can set a button to link to an external file or executable by dragging the “External Program” 
procedure onto the button, then changing its Name and entering the filename of the file/executable 
into its Parameters field. 

To add a drop-down menu to a Business Flow Menu: 

1. Click on the Drop Buttons item on the Menu Designer Toolbox. 

2. Select the style of button (Standard, Focus or Transparent), then click anywhere on the WorkSpace 
to place it. 

Note: Transparent buttons allow more than one image to be specified. These images correspond to 
the various states of the button, e.g. inactive, active, hover. 

3. Enter any parameters that may be required, then click OK. 

4. Size and position the button using the CTRL and SHIFT keys. 

5. Enter some text into in the Filter field to filter the list of available procedures. 

6. Drag a procedure from the list onto the button. (To add a sub-menu, drag .) 

7. Enter any parameters that may be required, then click OK. 

8. Repeat steps 5 – 7 for all other procedures you want to be available from the drop-down menu. 
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Note: You can add sub-menus by dragging the “SubMenu” item onto the dropdown button. To add 
items to the submenu, select it so that its components appear on the Component Browser, then drag 
items onto its name at the top of the Component Browser. 

The drop-down menu works in real time on the Menu designer: click on the menu to view the items that 
will appear under it. 

To add graphical elements to a Business Flow Menu: 

1. Click on the Label, Image or Line item on the Menu Designer Toolbox, then click anywhere on the 
WorkSpace to place the item. 

2. Enter any parameters that may be required: 

o For labels, this includes the label text. 

o For images, this includes the image file to display. 

o For lines, this includes the line style and orientation. 

3. Click OK. 

4. Size and position the item using the CTRL and SHIFT keys. 

To add a tabbed layout to a Business Flow Menu: 

Two varieties of tabbed layouts are available: Standard and Enhanced. Enhanced layouts allow 
transparency and mouseover effects; Standard layouts do not allow these effects, but are more flexible 
with how tab buttons can be arranged. 

1. Click on the MultiPage > Standard > MultiPage or MultiPage > Enhanced > MultiPage item on the 
Menu Designer Toolbox, then click anywhere on the WorkSpace to place it. 

Tip: Standard MultiPages have a TabPos property that lets you specify which side of the MultiPage 
tabs will appear on. Enhanced MultiPages can only have tabs at the top. 

2. Size and position the MultiPage using the CTRL and SHIFT keys. 

3. Click on the MultiPage > Standard > Tabsheet or MultiPage > Enhanced > Tabsheet  item on the 
Designer Toolbox, then click on the MultiPage. Enter a name an optionally an image then click OK. 
This adds a tab to the top of the MultiPage. 

Note: Enhanced Tabsheets allow more than one image to be specified. These images correspond to 
the various states of the tab button, e.g. inactive, active, hover. 

4. Repeat step 3 to add more tabs to the Multipage. 

5. Click on a tab, then drag other items such as links and buttons onto the MultiPage. These items will 
only appear when that tab is clicked. 

6. Click on another tab. The items you added to the previous tab will disappear. Drag more items to 
the MultiPage for this tab. 

7. Repeat steps 5 and 6 for all tabs. 

The tabbed layout works in real time on the Menu designer: click on a tab to view the items that will appear 
on that tab. 

To add a Dashboard interface to a Business Flow Menu: 

A procedure called “Dashboard” is available in the list of procedures; dragging this procedure onto a 
Business Flow Menu means that a Dashboard interface (see page 539) will be available when running the 
module. The Dashboard can be customised and widgets can be added to it at run time. Enter “D” into the 
Custom field for the procedure to indicate that it can be “docked” in the WorkSpace, so that it appears as 
part of the core EXO Business interface, rather than appearing in a new window. Enter “DR” to indicate that 
it is dockable and resizable. The Align property should be set to “Client”. 
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It is also possible to add a working Dashboard interface that can be edited at design time: 

1. Click on the Panels > Dock Panel item on the Menu Designer Toolbox, then click anywhere on the 
WorkSpace to place it. A Dashboard interface appears on the WorkSpace. 

2. Size and position the Dashboard using the CTRL and SHIFT keys. 

Tip: To have the Dashboard take up all of the available area, set its Align property to “Client”. 

3. Click on the Panels > Panel item on the Menu Designer Toolbox, then click on the Dashboard. This 
adds a panel and automatically converts it to a Dashboard widget. 

4. Repeat step 3 to add more widgets to the Dashboard. 

5. Click on a widget, then drag other items such as links and buttons onto the widget. Repeat for all 
widgets. 

Menu Definition 
A menu definition is a set consisting of a Dropdown Menu and a Business Flow Menu. Menu definitions are 
associated with users at Staff > Users, and determine which menus will be used for that user. 

Tip: The definition assigned to the current user is highlighted in green. 

To set up a menu definition: 

1. Click New to create a new definition, or Edit to alter an existing one. 

2. Enter a Name for the definition. 

3. Select the Drop Down Menu for this definition. 

4. Select a Business Flow Menu for this definition, or click Clear if you do not want to display a 
Business Flow Menu. 

5. Click Save to save the settings. 

Analysis Codes 

Analysis Codes are arbitrary codes that can be assigned to transactions. They do not perform any function 
themselves and are independent of the normal grouping of account codes; they are simply a customisable 
way of grouping related transactions together for sorting and reporting. This allows you to collect and 
monitor income and expenditure for a particular function or event that is not captured by the use of a 
project code or class, i.e. allows for much finer segmentation. 

Once Analysis Codes are set up, they can be assigned to line items in all transaction types. A transaction can 
have more than one code assigned to it. 
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Setting up Analysis Codes 
Analysis Codes are set up in the MYOB EXO Business Configuration Assistant (see page 52). Codes are 
grouped into CodeSets; before you can create Analysis Codes, you must set up at least one CodeSet. 

Note: A maximum of five CodeSets may be created. 

To set up a CodeSet: 

1. Open the Configuration Assistant and go to Essential > Analysis Codes section. 

2. Click the New CodeSet button. 

3. Enter a name and description for the set. 

4. If you want the codes in the set to follow a specific pattern, enter a code template in the Analysis 
Code Validation field. A code template is a string consisting of the letters A and N, where A 
represents an alphabetical character and N represents a numeric character. For example, entering 
the template “AANNN” means that all codes in the set must consist of two alphabetical characters 
followed by three numbers. If you do not enter a template, codes can contain any characters. 

5. Click Save to save the CodeSet. 

Analysis CodeSets must be active in order for users to be able to assign the codes they contain to 
transactions. Activate a CodeSet by ticking its Active box. A CodeSet must have at least one code in it 
before it can be activated. 

Analysis codes can be created directly under a CodeSet, or under another code. 

Adding Analysis Codes 
To add an Analysis Code: 

1. Select the Code or CodeSet you want to create the code under and click New Code. 

2. Enter the code. If a template has been defined for the code’s CodeSet, the code entered must 
match the format of the template. The code is highlighted red if it does not match the template. 

3. Enter a name and description for the code. 

4. Click Save to save the code. 

Default Analysis Codes can be assigned to users at Configuration Assistant > Staff > Users. These codes will 
be assigned by default to any transaction entered by the user. 

Analysis Code Profile Settings 
The following Company-level profile settings may need to be configured: 

• Default analysis codes required - specifies whether or not default Analysis Codes must be specified 
for each user at Staff > Users. 

• Analysis codes mandatory for every transaction - specify whether or not one or more Analysis 
Codes must be selected for every transaction entered. 

• Maximum number of analysis codes per transactions - enter the maximum number of Analysis 
Codes that can be applied to a single transaction. 

• Hide Analysis Codes Column - if you do not intend to use Analysis Codes, this setting can be used to 
hide the Analysis Codes column on the Sales Order, Purchase Order, Creditors Invoice, Debtors 
Invoice, Cashbook and Journal entry windows. 

The following User-level profile setting may need to be configured: 

• Permit editing of Analysis Codes assigned to a transaction - specify whether or not users can alter 
the Analysis Codes assigned to a transaction. The user’s default Analysis Codes are always applied, 
even if they are not permitted to edit them. 
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Head Office and Branch Accounts 

About Head Office and Branch Accounts 

MYOB EXO Business supports head office and branch accounts. This is useful for dealing with franchise or 
multi-branch Debtors or Creditors. 

A guiding principle to use with this function is that purchase/sale analysis and stock-related functions are 
performed using branch accounts; accounts payable /receivable functions are performed using head office 
accounts. 

• Head Office Account - Transactions for the branch accounts are assigned to it. Statements 
produced for the Head Office Account will also list transactions. 

• Branch Account - When a transaction is entered on to a Branch account, it will automatically 
update the Head Office account that this account is connected to. Transactions can be viewed from 
either the Branch account or the Head Office account. 

Head Office and Branch accounts are clearly labelled on the Debtors/Creditors account window: 

 

 
In the toolbar are two toolbar buttons specific to the head office/branch functionality: Show Branch  and 
Show Head Office . If you are viewing a Branch account, you can click the Show Head Office button to 
view the Head Office account; if you are in the Head Office account, you can click the Show Branch button 
to view branches of the head account. 

Rules for Assigning Branches to a Head Office 
• A branch may not be assigned to another head office. 

• A branch may not be a head office itself (i.e. only two levels are allowed). 

• A branch must be an active account. 

• All members of a group (head office and branches) must have the same currency, e.g. a foreign 
currency account cannot be connected to a non-foreign currency amount. 

If a head office is put on stop credit, then all the branches will also be placed on stop credit. 

Reports 
Reports will give individual sales and purchasing analysis on branch and head office accounts. Statements 
however, give a consolidated view of transactions for a period via the head office account. Statements for 
the individual accounts may be printed but will only show transactions that have not been transferred to 
the head office account, i.e. those transactions that existed prior to the branch being assigned to a head 
office and were explicitly transferred to the head office account. 
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Advanced Head Office/Branch Features 
If you have the MYOB EXO Business Configurator, the following advanced profile settings are available. 

Profile Setting Description 

Hide ‘send to head office’ 
button on debtor account 
screen – User Profile 

Enabling this option will hide the Send to Head Office button on the 
debtor account window. This setting would be used in conjunction 
with the “keep transactions” setting above. 

Hide ‘keep trans’ checkbox 
in debtor account screen – 
User Profile 

Enabling this option will hide the Keep trans checkbox in the Debtor 
Account window. This setting would also be used in conjunction with 
the “keep transactions” setting above. 

Keeping transactions with the branch account or head office option 
This is an advanced feature only available to MYOB EXO Business Configurator users. 

This is a profile setting which provides a different method of handling debtors Head Office / Branch 
relationships.  It is not available for creditor accounts. 

Using this method you have the option of allowing branch accounts to retain their transactions and to 
receive payments but to have a consolidated view of the purpose of reporting total balances at head office 
level, and for producing a consolidated statement.  A summarise option is included on head office account 
details 1 tab, which will toggle the head office account balance to be the sum of its own posted 
transactions, or to be that of itself and all its independent children. 

Once the profile setting has turned on, the user is able to select whether or not this profile takes effect via 
the keep track trans check box in the debtors account window.  The profile setting Hide ‘keep trans’ 
checkbox in debtor account screen could be used to control whether users have the option. 

Transactions 
Transactions are shown only in the branch accounts to which they belong. You can only receipt payments 
for branch invoices in the head office account, as all transactions are automatically transferred to the head 
office account. 

If you have MYOB EXO Business Configurator, you can explicitly transfer transactions to the head office 
account by clicking the button in the branch account window and then they are visible in both accounts. 
This action transfers all existing transactions from the branch to the head office account and sets the 
branch account aged balance to 0. The profile setting Hide ‘send to head office’ button on debtor account 
screen could be used to control whether users are able to perform this action. 

Transferring Branch Transactions to Head Office 

If you have MYOB EXO Business Configurator, you can manually transfer branch transactions to the head 
office account: 

1. In Account > Debtors select the required branch from the list of debtors. 

2. Click the Send to Head Office  button to transfer all transactions from the branch account to its 
head office account. The aged balance for the branch account will be set to 0 and the head office 
aged balance will be adjusted to reflect the added transactions. 

As the system stands at present, in order to allocate a transaction within this function, the 
transaction must be transferred to head office. 

3. Click the Show Head Office button (within the branch account) to view the head office account. 
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Payments 
Because transactions are automatically posted to the head office account, payments are also receipted 
from the head office account. When a branch account is selected for this purpose, the account that appears 
is the branch’s head office account and therefore a consolidated list of unallocated transactions from all 
branches is displayed for the purpose of allocation. 

If you have MYOB EXO Business Configurator, and have set the Send to Head Office button to be visible, 
payments may be received from both branch and head office accounts although only transactions which 
belong to the branch are able to be allocated against i.e. if a transaction has been transferred to a head 
office account then it may not be allocated against via the branch account.  Likewise, a payment for a 
transaction remaining in a branch account (and not transferred) may not be allocated via the head office 
account. 

In the head office branch consolidation window, you can click on the View Transactions button to view 
transactions of the highlighted branch. 

Setting up and Viewing Head Office and Branch Accounts 

1. In Account > Debtors or Account > Creditors select the account that is to be the head office 
account. 

2. Double-click this account. The account should open defaulting to the Details 1 tab. 

3. Click the Show Branch  button to view, set up or link the branches. The following window opens: 

 
Branches that belong to this Head Office will be listed here along with their aged balances. 

Column Description 

Accgroup The Debtors or Creditors Account Group of the account. Branch and Head 
Office can belong to different account groups (but must be of the same 
currency). 

Group The Debtor’s/Creditor’s Account name. 

Keep Trans This is set to ‘N’, as all branch transactions are automatically transferred to 
the head office account. 

If you use MYOB EXO Configurator, this is optional, and can be set to ‘Y’ to 
allow branch transactions to stay with the branch account. 
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Account No The Debtor or Creditor account number. 

Alphacode The Account code. 

Name The full name of the account. 

Balance The total balance of the account, with a total line of all branch accounts at 
the bottom of the grid. 

Current Current balance 

30 Days 30 day outstanding balance. 

60 Days 60 day outstanding balance. 

90 Days 90 day outstanding balance. 

This Month TO The Total for this month 

Last Month TO The Total for last month 

This Year TO The Total for this year 

Last Year TO The Total for last year 

4. To view account details for an existing branch, double-click on the preferred branch. The debtor 
account window for the selected branch will then be displayed. 

5. To add branches, click on the Add button. The Account Search window opens. Select an existing 
account, or Click New to create a new one. If a particular account is not displayed, it will be because 
it’s not eligible to be selected, in accordance with the rules for assigning branches to a head office 
(see page 84). 

Once you have added a Branch account to a Head Office, all future transactions are automatically 
transferred to the Head Office account. If you have EXO Business Config, you can also transfer existing 
transactions to Head Office. 
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Debtors 

This section details the functions related to debtors. It describes how you set up debtor account groups and 
debtor accounts as well as the major customer and sales-related tasks you perform such as Credit Control 
and Sales Order Invoicing. 

Based on the options you have selected in MYOB EXO Business (Local, General and Staff security setup 
sections), you are able to perform certain functions. You can decide whether your invoices should include 
or exclude GST by selecting from the options in MYOB EXO Business Configurator > Essential > General 
Settings. You can also check options to allow you to accept deposits against sales orders. When creating 
sales orders, you can set the system to provide you with additional functions as Standing Orders, Quotes 
and Laybys. 

From the initial Debtors window you can search for a Debtor (see page 7) or create a new Debtor. 

Creating a New Debtor 

To create a new Debtor: 

1. Go to Accounts > Debtors or press F3. 

2. From the Debtor Account Details window, click the New button. The window now refreshes, 
displaying the Details 1, Details 2 and Extra Fields tabs, with the Details 1 tab selected. 

3. Complete the fields in the Details 1 tab (see page 91) and Details 2 tab (see page 94). 

4. Click Save. Additional tabs are now created. 
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Debtors Master 

Accounts > Debtors 

Debtor account management within MYOB EXO Business is very powerful. Debtor accounts can be grouped 
to suit the requirements of the business and the Debtors Account Details window contains all the 
information related to the account, e.g. Debtor details, contacts, transactions, notes, price policies. 

 
Information is spread across the following tabs: 

Details 1 (see page 91) – contains the primary company information, including details, sales and credit 
information, price setup, account type flag and other system maintained information. 

Details 2 (see page 94) – holds the secondary information about the company, including payment info 
(including prompt payment discounts), banking details, tax registration, auto order template, invoice 
format control and pop up alert text. 

Contacts (see page 118) – provides the Debtor’s contact details. Users can add, delete or edit contact 
information. Users can easily create documents for the contact person, and an email facility is also 
supported from this window. 

Transactions (see page 125) – users can view all transactions related to the Debtor, e.g. payments, 
invoices, credit notes, adjustments, and allocations. Each transaction provides details related to the 
transaction such as the date, kind of transaction and the amount. Users can also email invoices and 
statements from this tab. 

Orders (see page 96) – allows viewing of the sales orders for this Debtor, its statuses and order amount. 
New sales orders can also be created from this window. 
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Extra Fields (see page 135) – Debtor accounts support 24 extra fields that can be defined to suit the 
company needs. The first three extra fields are displayed on the details1 tab and the rest on the extra fields 
tab. The fields available here are set up at EXO Business Config > System > Extra Fields. 

Serials (see page 135) – this shows a list of all serialised stock items that were bought by this account. 

Discounts / Prices (see page 96) – this tab displays all the price policies and price rules to be used on this 
account. 

Jobs – displayed when the EXO Job Costing module is installed, this tab lists all jobs related to the 
account. It displays the jobcode, jobno, status, order no and start and due date. 

Notes (see page 137) – this tab provides a ‘free-form’ way for users to record any communication or 
general information related to the Debtor. Users can insert the username and date/time when the info is 
recorded and common phrases (see page 139) can be entered easily. This is a very useful tool for entering 
conversations and events relating to the Debtor. 

History Notes (see page 137) – this is like the Notes tab, but is more structured. This makes it easier to 
search for previous notes related to the Debtor. It’s also easy to create, delete, or email history notes. 

Documents (see page 140) – lists all the documents related to a Debtor account. It could be a word 
processing document, a graphical .gif or .avi file, or any document that is recognized by a Windows 
application. 

Analysis (see page 98) – displays a graph that gives a quick view of the sales performance, and allows 
comparison of the sales through the year. This will help to forecast future sales. 

Relationships (see page 141) – displays the relationships that have been made between this account and 
other entities in the EXO Business system. 

Opportunities – displayed when functions from the EXO Business CRM module have been added to the EXO 
Business core, this tab displays all sales opportunities related to the account. 

Activities (see page 144) – displays and tasks and appointments associated with this account. 

Serviceable Units – displayed when the EXO Job Costing module is installed and the optional Serviceable 
Units feature is enabled, this tab lists all Serviceable Units assigned to the account. 

Social (see page 147) – displays information about the Debtor from various social media services. 

Notes 

• The toolbar buttons at the top of the Debtor Account Details window change when moving 
between tabs. 

• There can only be one default contact per Debtor, and the default contact cannot be deleted. 

• The Debtor Stop Credit flag prevents transactions being saved. 

• MYOB EXO Business supports a Parent/Child account relationship. 

• Support exists for different invoice formats for Debtor Invoices, used for both normal invoice 
printing and invoice batch printing. 
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Setting up Debtors 

Setting up Debtor Account Groups 
You can use Debtor Groups to group Debtor accounts together. For example you might set up your regions 
as Debtor Groups. You might use the Secondary Debtor Group for the type of client, such as wholesaler, 
retailer, or state and interstate. You can then report on Debtor Groups and add them to search windows as 
extra fields. 

Debtor groups are distinct from Debtor Price Policy Groups, which are only used for pricing purposes. 
Examples of Debtor Price Policy Groups might be “trade”, “internet” or “foreign”, where there is a need for 
a different pricing approach. 

You can create account groups that are suited to the requirements of your business. When you set up 
Debtors, you can assign them to one of these groups, for reporting and associating price policies. 

To set up a Debtor Group: 

1. In the MYOB EXO Business Configuration Assistant, go to Administration > Debtors > Debtor 
Account Groups from the menu on the left. The Debtor Account Group window opens. 

2. Click on the New button to create a new group. 

3. In the Account Group Name field, enter a name for this group. 

4. In the Report Code field, enter the report code. 

5. Click Save icon from the menu. 

A new Account Group is created and added to the list. The Account Group number is automatically 
assigned. 

Debtors Details 1 Tab 
The Details 1 tab is used to store the primary information for the Debtor, including contact details, sales 
and credit information, price setup, account type flag, and other system-maintained information. 
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Company Details 

Field Description 

Code The Debtor code is automatically populated, but you can change it now if you 
prefer. 

Name Enter the name of the Debtor here as it should appear in the statements and 
invoices. 

Postal Address Enter the postal address of the Debtor. If the delivery address is the same as the 
postal address, press the Tab key on the last address line to automatically copy 
this information to the delivery address field. 

Postal Code Enter the postal code if it is known or select the postal code from the Postcode 

Lookup window opened by clicking the  button. 

Delivery Address Enter the Delivery address for the Debtor. Note that an additional Line 5 and 
Line 6 appear beneath the country. You can use these lines to enter additional 
address information. 

Email Enter the primary Debtor email address. 

Phone Enter the primary Debtor phone number. 

Fax Enter the primary Debtor fax number. 

Contact name The default contact for the Debtor account. This is set in the Contacts tab (see 
page 118) of the Debtor account, and can be changed. 

Sales Details 

Field Description 

Primary Group Select the primary Debtors Group (see page 91) that this Debtor is related to. 

Secondary Group Select the secondary Debtors Group (see page 91) that this Debtor is related to. 

Sales Person Select a staff salesperson to be assigned to this account. This is optional. Any 
transactions against this account will then be logged against this staff member. 

Base Price Choose which base price you want to assign this Debtor to. For example, you 
might have set up a base price called ‘trade’, and another called ‘internet’, and 
determined different pricing rules for these. 

Select the Debtor Price Policy Group (see page 434) for this Debtor. 

Turnover Turnover totals of the Debtor account, for the current month, last month, year 
to date and last year, are displayed here. 
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Credit Limit Information 

Field Description 

Credit terms Enter the credit terms you want to use for this Debtor. This may already be set to 
your company default credit terms for a new account. 

Credit Limit Enter the credit limit you want to use for this Debtor. This may already be set to 
your company default credit limit for a new account. 

Currency If you are using multiple currencies, choose the currency you are trading in with this 
Debtor in the Currency field. Once selected, all transactions with this customer are 
in this currency. You cannot change the currency of a Debtor account once the 
account has transactions posted to it. 

Aged Balances Aged balances for the current and previous one, two and three months, and a total 
balance, are displayed here. 

Additional Flags 

Field Description 

Active This flag indicates whether the Debtor account is active or inactive (see page 101). If 
inactive, the account is hidden from the main Search view. 

Open item A check if you want to display all outstanding items on statements rather than only 
a Balance Brought Forward statement. 

You must check this option if the account is a foreign currency account, or if you are 
calculating GST on a payments basis. Leave the box unchecked, if you want this 
account to be a Balance Brought Forward account. 

Stop credit If this checkbox is ticked, the Debtor account is on stop credit (see page 100). This 
means no further transactions can be processed. Accounts on stop credit are 
indicated by a red band across the top of the account window. 

Need Ord No If the profile setting Validate Debtor Order Numbers in the Configuration Assistant 
is enabled, then tick this checkbox if you want order numbers checked against past 
order numbers to prevent duplication. 

Account 
Template 

If this checkbox is ticked, this Debtor account will be used as a template for Non 
Accounts and new POS accounts. 

Allow 
Restricted 
Goods 

If this checkbox is ticked, you can sell any stock items that have been flagged as 
restricted goods (see page 101) to this Debtor. 

Note: You can enable the Use customised customer stock restrictions logic 
Company-level profile setting to customise and extend the Restricted Goods 
function. When this setting is enabled, EXO Business uses the 
FN_RESTRICTED_ITEM function to determine if a Stock item can be sold to a 
Debtor - this function can be customised to suit the needs of your 
organisation. 
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Private 
Account 

If this checkbox is ticked, this account is classed as private (see page 101). Whether 
or not this account can be accessed by this level of user depends on how the Allow 
Access to Private Debtor Accounts user profile setting is set. 

 

Debtors Details 2 Tab 
The Details 2 tab is used to store secondary information about the Debtor, including payment information 
(including prompt payment discounts), banking details, tax registration, auto order template, invoice 
format control and pop-up alert text. 

Payment Details 

Field Description 

Default Payment Type Select from the drop down list What payment method the debtor will 
generally use. 

Bank Account 
Number 

The BSB (Bank State Branch) number for the bank and branch at which the 
debtors account is held. 

Bank Account Name The name of the account. 

Advice Notification The method of advice notification preferred by the debtor. Tick each 
checkbox to enable the advice notification type. 

Prompt Payment Details 

Field Description 

Discount (%) The discount percentage being offered. Enter an integer between 0 and 100 
and exclude the % designator. 

Amount The discount amount being offered. 

Do Not Accept Cheque Whether or not cheques will be accepted from this debtor. 

Social Media Details 

Field Description 

Facebook The Debtor’s Facebook account ID. This can be a numerical ID, or a Facebook username, 
if they have one. 

LinkedIn The Debtor’s LinkedIn account ID. This must be the numerical ID. 

Twitter The Debtor’s Twitter account username. 

Note: If you do not know these details, you can search for them on the Social tab (see page 149). 
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GST Details 

Field Description 

ABN The Australian Business Number (ABN) of the debtor. (Aus) 

GST The GST number of the debtor. (NZ) 

Override GST 
rate 

The default GST rate for the country will default in here. You can override the 
default GST rate for this debtor here. 

Miscellaneous Details 

Field Description 

Auto Order Template A Bill of Materials (see page 505) order template. Manufacturing use only. 

Invoice File You can use multiple invoice layouts in MYOB EXO Business (see page 99). 
Invoice formats need to be saved with the invoice# filename. 

Enter the number that is used in the invoice template name that will be used 
for this Debtor, i.e. to select invoice2.clf, enter ‘2’; to select invoice5.clf, 
enter ‘5’, and so on. Leave the value as ‘0’ to use the default invoice.clf 
template. 

Statement Delivery Select how statements should be delivered to this Debtor. Choose from: 

• None - No statement will be sent to the Debtor. 

• Email - Statements will be sent to the Debtor via email. 

• Print - Printed statements will be mailed/faxed to the Debtor. 

• Both - The Debtor will be emailed statements and also sent printed 
copies. 

Statement Contact When sending statements via email, the email will be sent to the address of 
the contact selected here. 

Invoice Type Select the type of invoice to send to this Debtor. Choose from: 

• DEFAULT - Use the default invoice type, as determined by profile 
settings. 

• STANDARD - Use standard MYOB EXO Business invoices for this 
Debtor. 

• M-POWERED - Use the MYOB M-Powered Invoices service (see page 
393) for this Debtor. M-Powered Services need to be available on 
your system to use this feature. M-Powered Services are available in 
Australia only. 

Pop-up Alert 

Field Description 

Pop-up Alert A note you would like to appear when dealing with this debtor. This could be a 
reminder about certain preferences they may have. 
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Debtors Orders Tab 
This tab is used to view Sales Orders for the Debtor. You can also create new Sales Orders, quotes, standing 
orders and laybys. For a specific Sales Order, you can print an order, print a backorder, print a proforma 
invoice, and view the sales order history. 

There are several filters available to enable you to quickly find the sales order you require; several of these 
allow you to filter by Order Status (see page 306). 

Sales Order Details 

The grid header fields are detailed in the table below: 

Column Description 

Order No The Sales Order number. 

Status The status of the sales order. 

Order Date The date the Sales Order is created, 

Due Date The expected time of arrival to the customer of the sales order. 

Cust Order No A record of the customer’s order number. 

Reference The code that you use as a batching system if you are entering standing orders 
(see page 379). 

Total Value As the name implies, this is the total value of the order. 

Additional Sales Order tasks are available the right-click menu: 

Option Description 

Print Order Prints a packing slip of the order, itemizing each item in this order. 

Print Backorder Print a backorder 

Print Proforma Print the proforma invoice for the selected sales order. 

View Sales Order 
History 

View the history of the sales order. See View the history of a sales order (see 
page 363). 
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Debtor Discounts/Prices Tab 
Account > Debtors > {Select a Debtor} > (Discounts/Prices) 

The grid header fields are detailed in the table below: 

Field Description 

Price Policy Group This is the Debtor Price Policy Group (see page 434) to which this Debtor 
account belongs. 

(Price Policy grid) 

Policy # The price policy number. 

Policy Reference The name of the price policy. 

Customer Reference The customer’s own price agreement reference number, if they keep a record 
of supplier prices and discounts for price checking. 

Start Date The activation date of the price policy. 

End Date The end date of the price policy. Note that the start and end dates of a price 
policy will override the start and end dates of any included price rules; if the 
end date of a price policy extends beyond the end date of an included price 
rule, a prompt is displayed. 

Fixed If checked, this means that although lower prices may be available (or may 
become available in time) that the price rules contained in this policy are 
absolute and are always applied regardless of normal price logic. These prices 
may be considered as agreed. 

(Price rule grid) 

Stock Code Used to search for a specific stock item’s price rule. 

Description The description of the stock item. 

Stock Group The stock group code to which the stock item belongs. 

Group Name The stock group description. 

Start Date The start date of the price rule. 

Stop Date The end date of the price rule. 

Sell Price Band The base price 

Discount % The discount percentage of the price rule. 

Price The new price of the discounted stock item, or blank if a stock group price rule. 

Min. Qty The minimum quantity that is to be purchased in order to receive a discount. 

Policy Reference The name of the price policy. 
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Menu Items and other commands 

Click the Setup Price Policies button to set up Price Policies (see page 433). 

 
1. Creates a new Price Rule (see page 446) 

2. Delete the selected Price Rule 

Debtors Analysis Tab 
The Analysis tab displays a graph that gives a quick view of the sales performance, and allows comparison 
of sales through the year. This will help to forecast future sales. 

 
The Average Debtor Days value indicates the average number of days that the debtor takes to pay their 
invoices. This value is only visible if the Show average debtor days profile setting is enabled. 

Tip: The main logic for this calculation is in a stored procedure called 
DR_CR_ALLOCATION_AVE_DAYS_SP. The Number of months of debtor transactions to be used for 
Average Debtor Days calculation profile setting specifies how many months of debtor transactions 
to use when calculating the average (the default is 99). 

Right-clicking on the graph provides you with the option to copy the graph into another Windows 
application such as Word or Excel. You can also print the graph. 
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Working with Debtors 

Specifying an Invoice Template for a Debtor 
If you want to use different invoice formats for different kinds of customers or sales, you can do this in 
MYOB EXO Business by specifying a specific invoice template for each Debtor. 

By default, if there is no invoice template specified for a Debtor, the invoice template Invoice.CLF will be 
used. To use a specific invoice template for a specific Debtor, the invoice template must be set up in EXO 
Business Config, and then selected on the Details 2 tab of the Debtor account (see page 94). 

To set up invoice templates in EXO Business Config: 

1. Open EXO Business Config and go to the Forms section. 

2. Search for the Invoice form files profile setting. 

3. Enter the file names of all invoice templates, separated by commas. File names must be of the 
format “InvoiceX.CLF”, where X is the number of the template. 

 
4. Click Save. 

To specify an invoice template for a Debtor: 

1. Select the Debtor you want to specify the invoice template for. 

2. Click on the Details 2 tab. 

3. In the Invoice file field, enter the number that is used in the invoice template name that you want 
to use, e.g. to select invoice2.clf, type ‘2’ in the Invoice file field; to select invoice5.clf, enter ‘5’, and 
so on. 

4. Click Save. 
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Viewing the Aged Balances of a Debtor 
You can view the Aged Balances of a Debtor in the Debtor Account Details window, in summary in the 
Details1 tab of the debtor account, and in detail in the Transactions tab of the debtor account. 

Note: If you have the MYOB EXO Business Configurator, there is profile setting to be able to change 
the Aged Balances of a debtor account. 

1. Open the required debtor account. 

2. Review the aged balances in the Credit Terms frame in the Details1 tab. 

 
3. To view the transactions that make up each period total, click on the Transactions tab. For each 

highlighted period in the Transactions by Period frame, the transactions are highlighted in the 
transaction grid below. 

Putting a Debtor on Stop Credit 
The Stop Credit status on an account will highlight the account as being on Stop Credit for any user opening 
the Debtor account. A warning will be displayed if any user tries to process a sale or invoice for this Debtor 
account. You cannot process a sales order for a debtor account on Stop Credit. 

You can still process a Debtor Receipt for the account. 

A reason log event exists for this action. If the event has been enabled, this action may be silently logged, or 
you may be prompted to select an event reason and enter any additional explanatory notes for this action. 

1. Open the required Debtor account. 

2. On the Details1 tab, tick the Stop Credit checkbox. 

3. Click Save. 

When any user next opens this debtor account, a red Stop Credit band appears at the top of the Debtor 
Account Details window. 

Taking a Debtor off Stop Credit 

To take a Debtor off Stop Credit, you can either: 

• Change the status when you are processing a Debtor Receipt for this account. 

• Change the status in the Details1 tab of the Debtor Accounts window. 

Note: You cannot clear the Stop Credit status unless you process a Debtor Receipt in this window. 

A reason log event exists for this action. If the event has been enabled, this action may be silently logged, or 
you may be prompted to select an event reason and enter any additional explanatory notes for this action. 
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To clear the Stop Credit status in the Debtor Receipts window when processing a debtor receipt for the 
account: 

1. Go to the Transactions > Debtor Receipts > Debtor Receipt. 

2. Enter the Debtor Receipts, including the amount of the Debtor Receipt. 

3. Uncheck the Stop Credit checkbox. 

4. Complete and save the transaction. 

Making a Debtor Account Inactive 
Making a Debtor account inactive will hide it from the default search view, and from search lookups from 
other transaction windows. However, you can still choose to include inactive accounts in your search, and 
then process a transaction such as a Debtor Invoice or Sales Order for an inactive account. 

You cannot make a Debtor account inactive that has an outstanding balance. In this case, the Active 
checkbox is greyed out and unavailable for selection in the Details1 tab. To make a Debtor account with an 
outstanding balance inactive, the Debtor first has to settle the outstanding balance, and then the account 
can be made inactive. 

1. In the Debtor Accounts window, locate the Debtor account you want to make inactive. 

2. Check that the balance showing in the Balance column is zero. If so, double-click on the Debtor. 

3. Clear the Active checkbox, then click Save. 

Note: New Debtor accounts can be automatically set to Active or Inactive by configuring the Set new 
debtor accounts as active Company-level profile setting. 

Making a Debtor Account Private 
A debtor account can be set to be a private account. If the Configuration Assistant has been set up to 
disallow access to private accounts, then when you try to open a debtor account from the search window, 
you will be blocked. 

(Each user is part of a user profile, and this profile setting can be set differently for each user profile, for 
example giving management visibility of all private accounts, but preventing admin staff from viewing 
them.) 

1. In the Debtor Accounts window, double-click on the debtor account you want to make private. 

2. In the Details1 tab, tick the Private Account checkbox. 

3. Click Save. 

Allowing a Debtor to Purchase Restricted Goods 
If a stock item is set to be a restricted goods stock item, then to sell that stock item, the Debtor must be set 
to allow restricted goods. When creating a debtor transaction such as a Debtor Invoice or Sales Order, if the 
Debtor is not set to allow restricted goods, the transaction will be blocked. 

1. In the Debtor Accounts window, double-click the required Debtor. 

2. In the Details1 tab, tick the Allow Restricted Goods checkbox. 

3. Click Save. 
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Adding Extra Delivery Addresses 
A Debtor account can have multiple delivery addresses associated with it. 

You can add extra delivery addresses either: 

• from the Debtor Account Details window, by clicking the Additional Delivery Addresses... toolbar 
button, or 

• from the Debtor Invoice Entry window, in the Payments/Delivery tab, when specifying delivery 
details for an invoice. If you enter a new delivery address when creating a new Debtor Invoice, the 
address will be saved with the Debtor account. 

 
To add a new delivery address: 

1. Click the New button. The following window is displayed: 
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Note: You can change the labels on each line of your delivery addresses using the MYOB EXO 
Business Configuration Assistant. 

2. To edit an existing delivery address, click the Edit the Selected Item button in the toolbar, and 
make any required changes. 

3. Save the edited, or new, delivery address. 

Changing the Credit Terms of a Debtor 
The default credit terms you can apply to a specific Debtor account are set up in the Finance section of the 
Configuration Assistant. For each credit term, you can: 

• specify whether it is active for Debtors or Creditors 
• choose one of four credit term option types: No credit - cash only; End of invoice month; Net days; 

Days from month following 
• create a warning, including the warning text to display, when credit terms are exceeded 

How credit terms behave in your implementation of MYOB EXO Business also depends on how the 
following profile settings have been set: 

• Debtor Credit Terms Default: New debtor accounts will inherit the credit term of this profile 
setting. 

• Debtor Balance Warning: Displays the warning set up in the credit term if invoice or sales order 
entry does not comply with the credit term. 

• Enforce Credit Terms: Enforces (not just a warning) when invoice/sales order entry does not 
comply with credit term. 

Credit terms are managed quite separately from how transactions are aged in MYOB EXO Business. 

To change the credit terms of a Debtor account: 

1. Open the required Debtor account. 

2. In the Credit section, select the required term from the Credit terms drop-down list. 

3. Change the Credit limit if required. 

4. Click Save. 

Note: If this is a child account, which does not have its own balance, the credit limit test will apply to 
the parent account instead. 
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Creditors 

This section details the functions related to Creditors. It describes how you set up Creditor Account Groups 
and Creditors as well as the major creditor-related tasks you perform such as Credit Control and Purchase 
Order Invoicing. 

Based on the options you have selected in MYOB EXO Business you are able to perform certain functions. 
You can decide whether your invoices should include or exclude GST by selecting from the options in MYOB 
EXO Business Config > Profiles. 

From the initial Debtors window you can search for a Creditor (see page 7) or create a new Creditor. 

Creating a New Creditor 

To create a new Creditor: 

1. Go to Accounts > Creditors. 

2. Click New to create a new Creditor account. The Creditor Account Details window (see page 106) is 
displayed with the Details 1 tab as the default page. 

3. Complete the entries in each field of the Details 1 tab (see page 106) and Details 2 tab (see page 
108). 

4. Click Save. Additional tabs are now created. 

Creditors Master 

Accounts > Creditors 

The Creditors account master concept is very similar to the Debtors master. Users can also setup Creditor 
account groups (see page 106) suited to the requirements of the business. 

 

104 



Working with Accounts 

Information on the Creditors Account Details window is spread across the following tabs: 

Details 1 (see page 106) – contains company details, purchases and credit information, account type flag 
and other system maintained information. 

Details 2 (see page 108) – holds payment info including prompt payment and vendor discount, banking 
details, default GST rate, maximum auto authorise amount, and pop-up alert text. 

Contacts (see page 118) – provides the creditor’s contact details. User can add, delete or edit contact 
information. Users can easily create document for the contact person and email facility is also supported on 
this window. 

Transactions (see page 125) – users can view all transactions related to the creditor, e.g. payments, 
invoices, refunds, adjustments, allocations, etc. Each transaction provides details related to the transaction 
as the date, kind of transaction and the amount. 

Orders (see page 110) – this is where you can view a list of purchase orders on their account, its statuses 
and order amount. New purchase orders can also be created from this tab. 

Extra Fields (see page 135) – debtor accounts supports 24 extra fields that can be defined to suit the 
company needs. The first 3 extra fields are displayed on the details1 tab and the rest on the extra fields tab. 

Serials (see page 135) – lists serial number information pertinent to the creditor account. Users can even 
view serial number history. 

Discounts/Prices (see page 110) – this tab displays all the discounts and price rules to be used on this 
account. 

Notes (see page 137) – allow users to record any communication or general information related to the 
creditor. Users can insert the username and date/time when the info is recorded and common phrases can 
be entered easily. This is a very useful tool for entering conversations and events relating to the creditor. 

History Notes (see page 137) – this is like the Notes tab, but is more structured.  This makes it easier to 
search for previous notes related to the debtor. It’s also easy to create, delete, or email history notes. 

Documents (see page 140) – lists all the documents related to a Creditor account. It could be a word 
processing document, a graphical .gif or .avi file, or any document that is recognized by a Windows 
application. 

Analysis (see page 111) – displays a graph that gives a quick view of the purchases performance, and 
comparison of the purchases through the year.  This will help to forecast future purchases. 

Relationships (see page 141) – displays the relationships that have been made between this account and 
other entities in the EXO Business system. 

Opportunities – displayed when functions from the EXO Business CRM module have been added to the EXO 
Business core, this tab displays all sales opportunities related to the account. 

Activities (see page 144) – displays and tasks and appointments associated with this account. 

Social (see page 147) – displays information about the Creditor from various social media services. 

Note: The toolbar icons at the top of the Creditor Account Details window change when moving 
between tabs. 
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Setting up Creditors 

Setting up Creditor Account Groups 
Setup > Business Admin Settings (General Setup) > [Creditor Account Groups] 

You can create account groups that are suited to the requirements of your business. When you set up 
Creditors, you can assign them to one of these groups. 

To set up a Creditor account group: 

1. Click New to add a new group. The Details tab is displayed. 

2. Enter a Name for the account group. 

3. Enter a Report Code for the account group. This is a user-defined report code to report on Debtor 
Price Policy Groups. 

4. Click Save. 

A new Account Group is created and added to the list. The Account Group number is automatically 
assigned. 

Note: Right click on the column heading for grid-related tasks. 

Creditors Details 1 Tab 
The Details 1 tab is used to store the primary information for the Creditor, including contact details, 
Creditor groups, account type flag, and other system-maintained information. 
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Field Descriptions 

Field Description 

Code The code that relates to the account. MYOB EXO Business automatically assigns a 
code. If you prefer, you can change the code by overtyping it. This code is 
primarily used for controlling the sorting of reports but also allows you to search a 
creditor. E.g. SMIT1 (Mr Smith) or JON1 (Jones Co Ltd). 

Name The name of the creditor as it should appear in statements and invoices. 

Company Contact Details 

Postal Address The creditor’s postal address. If the street name is the same, press TAB on the last 
address line to copy the Postal Address into the Delivery Address fields. 

Post code Enter the postal code if it is known or select the postal code from the Postcode 

Lookup window opened by clicking the  button. 

Delivery Address The delivery address. If it differs from the postal address, overtype it here. 

Contact The name of the main person to be contacted. 

Email The main e-mail address of the creditor. 

Phone The main phone number of the creditor. 

Fax The main fax number of the creditor. 

Extra Fields 

Default Code This is an example of a user-defined extra field (see page 23). 

Miscellaneous 

Primary The name of a primary account group, from the list. 

Secondary The name of a secondary account group, from the list 

Staff The name of the staff member who normally deals with this creditor. 

Credit Terms Select from the list to specify Cash Only or the method for due payment to the 
creditor. 

Currency The currency for transactions with this customer.  You cannot change the currency 
of a Creditor account once the account has transactions posted to it. 

Flags 

Active A check in this box to view the creditor’s account details. 

The box is checked by default. If the box is not checked, the account becomes 
inactive, and is hidden from the main search window. 
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Open Item A check if you want to display all outstanding items on statements rather than 
only a Balance Brought Forward statement. 

This is a default setting if you selected the New Accounts Defaults to Open Item in 
MYOB EXO Business Config > Profiles. You must check this option if the account is 
a foreign currency account, or if you are calculating GST on a payments basis. 
Leave the box unchecked, if you want this account to be a Balance Brought 
Forward account. 

Stop Credit If checked this will prevent further invoices being posted to this account. 

Private Account If checked, this account will become a private account. 

Toolbar Buttons 

 Note: These are only available once the initial values have been entered and saved in this tab. 

 

Send the transactions to the head office account. 

 

Edit aged balances. 

 

On a head office account, this button displays all branches; on a branch account, 
this button opens the head office account. 

Creditors Details 2 Tab 
The Details 2 tab is used to enter and store payment info including prompt payment and vendor discount, 
banking details, default GST rate, maximum auto authorise amount, and pop-up alert text. 

Field Descriptions 

Field Description 

Payment 

Default Payment 
Type 

Select the default payment method to this creditor. 

Bank Account 
Number 

The bank account number of the creditor. 

Bank Account Name The name of the bank account. 

Miscellaneous 

Default Invoice Mode Select default invoice mode. 

Primary Lead Time The number of days between placing an order and its arrival. 

Secondary Lead Time The alternate lead delivery time in days. 

Prompt Payment 
Discount (%) 

The percentage of discount being offered for prompt payment. 
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Remittance Contact Remittance advice will be emailed to the address of the contact selected here. 

Pop Up Alert Use this field to enter a user defined popup alert. 

Note: Use the ^ character to insert a carriage return. 

GST 

GST # Enter the company GST number here (New Zealand only). 

ABN Enter the company’s Australian Business Number here (Australia only). 

Override GST Rate The override GST rate. 

Track Taxable 
Payments 

Applies to Australian companies only. If you make payments to this Creditor 
for construction or building services, you will need to track these payments 
for reporting on the “Taxable payments annual report”. Tick this option to 
track all payments for this Creditor. 

Remittance 

Send M-Powered 
Payments 
Remittances 

This option is only available if “M-POWERED” is selected for the Default 
Payment Type. Ticking this box means that remittance advice will be sent to 
this Creditor whenever payments are made to them via the MYOB M-Powered 
Payments system (see page 334). 

M-Powered Services need to be available on your system to use this feature. 
M-Powered Services are available in Australia only. 

Remittance Method If the Send M-Powered Payments Remittances option is selected, specify 
how remittance advice should be delivered to this Creditor. Choose from: 

• None - No remittance advice will be sent to the Creditor. 

• Email - Remittance advice will be sent to the Creditor via email. 

• Print - Printed remittance advice will be mailed/faxed to the Creditor. 

• Both - The Creditor will be emailed remittance advice and also sent 
printed copies. 

E-Mail If remittance advice is to be sent by E-Mail, enter the address to send to. This 
defaults to the address on the Details 1 tab (see page 106). 

Fax If remittance advice is to be sent by Fax, enter the fax number to send to. This 
defaults to the number on the Details 1 tab (see page 106). 

Social Media 

Facebook The Creditor’s Facebook account ID. This can be a numerical ID, or a Facebook 
username, if they have one. 

LinkedIn The Creditor’s LinkedIn account ID. This must be the numerical ID. 

Twitter The Creditor’s Twitter account username. 
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Note: If you do not know a Creditor’s social media details, you can search for them on the Social tab 
(see page 149). 

Viewing Creditor Purchase Orders 
The Orders tab on the Creditor Details window contains a list of all Purchase Orders on the Creditor 
account. 

 
To filter the list of orders, check the options related to the type of orders you want to include. 

Note: If you have ticked the Enable extended sales order statuses Company-level profile setting in 
MYOB EXO Business Config there will be more check boxes here. 

The following toolbar-specific functions are available: 

• A new Purchase Order can be manually created (see page 309) from this window by clicking New 
Order > Manual Order. 

• A new Forecast Based Purchase Order (see page 316) can be created from this window by clicking 
New Order > Forecast Order. 

Creditor Discounts/Prices Tab 
Account > Creditors > {Select a Creditor} > (Discounts/Prices) 

 
Creditor discounts per stock code or stock price group are listed in a grid. These price rules are defined by 
clicking the New Price Rule button (see page 112). 
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Field Definitions 

The grid header fields are detailed in the table below: 

Field Description 

Stock Code The code you use to call up an item. A stock code can normally contain up to 
15 characters. 

Stock Price Group Stock items can be categorised and grouped on this category, this is the 
number assigned to this stock group. 

Group Name This is the name given to the stock group, detailed above. 

Price The price that applies to the stock item. 

Discount This is the discount in a percentage received for purchasing stock items in bulk 
quantities. This quantity is displayed in the Min. Qty field. 

Min. Qty This, as detailed above, is the minimum quantity that needs to be purchased 
from a creditor to receive the allotted discount. 

Start / Stop Date If this discount or pricing is over a predetermined period, this is defined by the 
start and end date displayed here. 

Creditors Analysis Tab 
The graph on the Analysis tab allows you to compare purchasing through the year. 

 
Tip: Right-clicking on the graph provides you with the option to copy the graph into another 
Windows application as Word or Excel. You can also print the graph. 
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Working with Creditors 

Creating a New Price Rule for a Creditor 
The Setup Cost Price window allows you to setup purchase prices from a creditor for a single stock item, a 
group of stock items with a discount applied. Similarly this is applied to stock price groups, where the group 
is any variety of similar stock items assigned to a group. 

Click the New Price Rule button on the Discounts/Prices tab of the Creditor Details window (see page 110) 
to open the Setup Cost Price window. 

 
To set up cost prices: 

1. For a single stock item, enter a Stock Code (if this is unknown, enter “?” and press TAB to open the 
Stock Search window). If the cost pricing is to be determined by a group, choose this group from 
the Stock Price Group dropdown. 

2. Enter the Price Type details in the fields provided. If stock price grouping is enabled, the supplier 
price option is no longer available. If an item is not available from the supplier, a substitute may be 
required. If substitutes are available, enter the cost price for the substitution item here. 

3. If discounts are attainable from the supplier, there may be Conditions to receive these, such a 
minimum order quantity. Alternatively these stock items may be sold only in batches, requiring the 
minimum quantity field to be completed. If discounts or prices are only for a predetermined period, 
enter the start and stop dates that define the discount period. 
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Non Accounts 

Accounts > Non Accounts 

Non Accounts let you add companies that aren’t yet Creditors or Debtors, e.g. sales prospects. A Non 
Account can be converted to a full Creditor or a Debtor account at a later date if necessary. 

Creating a Non Account 

To create a Non Account: 

1. Go to Accounts > Non Accounts. 

2. From the Non Account Details window, click the New button. 

3. Enter the following details on the Details tab: 

Field Description 

Name Enter the name of the account as it should appear throughout the MYOB 
EXO Business system. 

Phone Enter a contact phone number for the account. 

Fax Enter a fax number for the account. 

E-mail Enter an e-mail address for the account. 

Website Enter the account’s website address. 

Postal Address Enter the postal address of the account. 

Type This is a user-definable classification of the Non Account. Select the type of 
account that the Non Account is, or select “Edit List...” to create a new 
type. 

Base Price Choose which base price you want to assign this Non Account to. For 
example, you might have set up a base price called “Trade”, and another 
called “Internet”, and determined different pricing rules (see page 446) for 
these. 
Select the appropriate price band for this account. 

Sales Person Select a staff salesperson to be assigned to this Non Account. This is 
optional. Any transactions against this account will then be logged against 
this staff member. 

Postal Code Enter the postal code if it is known or select the postal code from the 
lookup window attained from the ellipsis [...] key. 

Contact 
Person 

The default contact for the Non Account. Contacts are set up on the 
Contacts tab for the account. Initially, this field will be empty - after you 
have created the Non Account and added Contacts for it, you can specify 
one of them as the default here. 

Notes The area at the bottom of the Details tab is a free-form notes area where 
you can enter any extra information about the account. 

4. Click Save. Additional tabs now become available, allowing you to edit all Non Account properties 
(see page 114). 
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Converting Non Accounts to Full Accounts 

Non Accounts can be converted to full Creditor or Debtor accounts if necessary. 

To convert a Non Account to a full account: 

1. Click the Convert to Debtor or Convert to Debtor toolbar button, depending on the type of account 
you want to convert the Non Account to. 

2. Click Yes when prompted to confirm the conversion. 

Non Account Details 

The available tabs on the Non Account Details window are detailed below. 

 

Details 

This tab contains contact and sales information for the Non Account. 

Field Description 

Name Enter the name of the account as it should appear throughout the MYOB EXO 
Business system. 

Phone Enter a contact phone number for the account. 

Fax Enter a fax number for the account. 
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E-mail Enter an e-mail address for the account. 

Website Enter the account’s website address. 

Postal Address Enter the postal address of the account. 

Postal Code Enter the postal code if it is known, or select the postal code from a lookup 
window by clicking the [...] button. 

Delivery Address Enter the delivery address of the account. 

Type This is a descriptive classification of the account. Select the type of account that 
the Non Account is, or select “Edit List...” to create a new type. 

Account 
Template 

Select the Debtor account that will be used as a template for the Non Account. 
Any pricing rules (see page 446) used by the template account will be applied 
when generating quotes for the Non Account, e.g. for an Opportunity when 
using EXO Business CRM. 

Note: Debtor accounts can be marked as templates by ticking the 
Account Template flag on the Details 1 tab of the Debtor Account Details 
window (see page 91). 

Base Price The base price to assigned to this Non Account - this is determined by the 
Account Template. For example, you might have set up a base price called 
“Trade”, and another called “Internet”, and determined 

Sales Person Select a staff salesperson to be assigned to this Non Account. This is optional. 
Any transactions against this account will then be logged against this staff 
member. 

Contact Person The default contact for the Non Account. Contacts are set up on the Contacts 
tab for the account. Initially, this field will be empty - after you have created the 
Non Account and added Contacts for it, you can specify one of them as the 
default here. 

Campaign Wave This field is available if the EXO Business CRM module is installed. If the Non 
Account is associated with a campaign wave, e.g. if it came about as a result of a 
campaign, the wave can be specified here. 

Facebook 
LinkedIn 
Twitter 

  

To view social media account information for the Non Account (see page 147), 
enter their usernames or logon IDs here. 

Note: The LinkedIn ID must be the numerical ID, not a username. The 
Facebook ID can be a numerical ID or a Facebook username, if one has 
been set up. 

Extra Fields If any Extra Fields (see page 23) have been defined for Non Accounts, fields in 
positions 1 - 3 will appear in this area, while any others will appear on the Extra 
Fields tab. 

Notes This area is a free-form notes area where you can enter any extra information 
about the account. 
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Extra Fields 

If any Extra Fields (see page 23) have been defined for Non Accounts, fields in positions 4 and later will 
appear on this tab. 

Contacts 

This tab lists all Contacts associated with the Non Account (see page 117). Use the toolbar to add and edit 
Contacts: 

 
1. New Contact: Create a new Contact and associate it with the Non Account. 

2. Associate a New Contact: Select an existing Contact to associate with the Non Account. 

3. Set as Default Contact: Set the selected Contact as the default Contact for the Non Account. This 
Contact will appear as the Contact Person on the Details tab. 

4. Remove Contact Association: Remove the selected Contact from the Contacts tab for the Non 
Account. (This does not delete the Contact from the system.) 

History Notes 

This tab works in the same way as the History Notes tab for Debtors (see page 137). 

Opportunities 

This tab is only displayed when functions from the EXO Business CRM module have been added to the EXO 
Business core. It lists all Opportunities associated with the Non Account. 

Activities 

This tab lets you associate activities (see page 144) with the Non Account in the same way as you do for 
Creditors and Debtors. 

Relationships 

This tab lets you specify relationships for the Non Account in the same way as you do for Creditors and 
Debtors. 

Documents 

This tab lets you attach documents (see page 140) relating to the Non Account. 

Social 

This tab lets you view information about the Non Account from various social media services (see page 
147). 
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Contacts 

Debtors, Creditors and Non Accounts all include a Contacts tab, where Contacts can be created and 
assigned to accounts. The Contact tab is a useful marketing tool; it contains a list of business Contacts 
associated with the main company. You can easily create marketing campaigns or documents that get sent 
to the right person (Contact) within the right company. 

Contacts can also be set up independently of accounts from the Contacts window, which is available under 
the Accounts menu. 

You may on a regular basis liaise with the accounts manager. However, the right person for the details 
about a new product being launched by your company may be the debtor’s Managing Director. So, you can 
mark the information directly to the director since you have the address and e-mail details on the Contacts 
tab. 

You can also maintain a record of how each Contact first heard about your business: newspaper, television, 
yellow pages or any other and determine the effectiveness of an advertising medium for your future 
campaigns. 

The two tabs, Details and Marketing, contain information about your Contact. The Notes field on the 
Details tab allows you to make brief notes about the debtor or Contact listed here. Any data stored on the 
Contacts tab can serve as a common pool of information for the Sales and Marketing team. 

Relationships can be formed between contacts and Debtors, Creditors, Non Accounts and staff. 

You can also add an Extra Fields tab with related information such as the Contact’s credit card number, 
birthday and hobbies. 

Contacts Master 

All account Contacts recorded in the EXO Business system can be viewed from the Contacts master, which 
is accessed by selecting Contacts from the Account menu. 

Note: To view the Contacts associated with a specific account, view the Contacts tab on that account 
(see page 118). 
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The Contacts master window displays the following details for all Contacts: 

Field Description 

First and Last Name The first and last (family) name of the Contact. 

Job Title The job title of the Contact. 

Phone The primary landline phone number for the Contact. 

Email The email address of the Contact. 

Mobile The primary mobile phone number for the Contact. 

Company Name The company name for the Contact. This will normally default to the company 
(Debtor, Creditor or Non Account) selected when creating this Contact. 

• To search for an existing Contact, enter search terms in to the Search Key field and click the Search 
button. 

• You can filter the list of Contacts by Contact List. Multiple classes can be selected. 

• You can filter the list of Contacts by Marketing Class (see page 123). Multiple classes can be 
selected. 

• Double-click on an existing Contact to edit it, or click the New button to create a new Contact (see 
page 120). 

• Click the  button to send an email to the selected Contact(s). 

• Click the  button to create and send a Clarity merge letter to the selected Contact(s). 

Right-click on a Contact for the following options: 

• Send Email - Send an email to the Contact (see page 44). (This option is not available if an email 
address has not been entered for the Contact.) 

• New Opportunity - Create a new Opportunity for the Contact. 

• New Activity - Create a new Activity for the Contact. 

• Selected Items > Export to Outlook - Export the details of all selected Contacts to Microsoft 
Outlook. (This option is only available if EXO Business CRM is licensed.) 

• Selected Items > Merge Letter with List - Create a merge letter (see page 531) to be sent to the 
selected Contacts. 

• Selected Items > Add to Contact List - Select a Contact List to add the Contact to. (This option is only 
available if EXO Business CRM is licensed.) 
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Contacts Tab 

The Contact tab on the Debtor, Creditor and Non Account screens displays details of the account’s 
associated Contacts. 

This tab lists all the Contacts that are associated with the account. From this window, you can add new 
Contacts to the account, set the default Contact for the account, and create and remove other Contact 
associations with the account. 

You can email a Contact from this window, or create a mail merge letter to them. 

Field Descriptions 

Field Description 

Title The job title of the Contact. 

Salutation The salutation for the Contact, e.g. Mr, Mrs or Dr. 

First and Last Name The first and last (family) name of the Contact. 

Direct Phone The primary landline phone number for the Contact. 

Mobile The primary mobile phone number for the Contact. 

Direct Fax The fax number of the Contact. 

Email The email address of the Contact. 

Home Phone The home phone number of the Contact. 

To edit an existing Contact, double-click on the Contact’s name in the grid. 

Contacts Tab Toolbar Buttons 
The Contacts tab is display-only; to create or change Contact information, use the toolbar buttons at the 
top of the window. 

 
1. Create a new Contact (see page 120). 

2. Set the selected Contact as the default Contact for this account. 

3. Associate an existing Contact with this account. 

4. Remove the Contact association. 

5. Send an email to the selected Contact (see page 44). 

6. Create and send a Clarity merge letter (see page 531) to the selected Contact. 

Adding a New Contact 
Click the New Contact button to add a new Contact (see page 120). 

Note: We suggest that you first search for the Contact (see page 117), as they might already be in 
the system. 
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Entering Contacts for an Account 

You can create new, view, or modify existing Contacts associated with an account. 

Account > Creditors or Debtor > {Double Click Account} > (Contacts) > [New Contact] 

1. In the Debtor/Creditor account, click on the Contacts tab. The Contacts tab lists all Contacts for the 
debtor account. 

2. Click the New Contact icon in the toolbar (  ). The Contacts window opens: 

 
3. Complete the fields in this table. 

• Click on the ellipsis button [...] beside the Name field to enter the salutation, first name and 
surname. 

• Click on the ellipsis button [...] beside the Postal code field to select the post code from a 
list. 

• Use the Copy Company Address icon in the toolbar if you want to copy either the postal 
address or delivery address from the current debtor account. 

• Check the Active checkbox to maintain the account of this debtor. 

These actions are detailed in the Field Descriptions below: 

Field Description 

Name The Contact name can be manually entered here, however it’s recommended that 
you use the name Check Full Name window to enter the details. Click on the 
ellipsis [...] button and select the Salutation, enter the First name and the Last 
name. Click OK to enter this full name into the name field. 

Company The company name for the Contact. This will normally default to the company 
(Debtor, Creditor or Non Account) selected when creating this Contact. 
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Job Title The job title of the Contact. 

Contact Details 

Postal and 
Delivery Address 

 
Use the Copy icon in the toolbar to copy details from the selected account. 
Selecting Copy company main details copies the following information to the 
Contact: 

• Postal Address 

• Phone 

• Fax 

• Email 

• Sales person 

Postal Code Enter the postal code if it is known; if not, click on the ellipsis [...] button to search 
and select a postal code. 

Phone Numbers 

Email 
Phone 
Fax 
Mobile 
Home Phone 

Complete these fields with as much information at hand. 

Flags 

Active This flag is enabled by default. If this Contact is to be inactive for any reason, 
disable this checkbox. 

Sync with 
Outlook 

If this flag is enabled, the Contact will be synchronised with Outlook whenever a 
sync is performed. If this flag is not enabled, the Contact will not be included in 
synchronisation operations. 

Opt-Out 
eMarketing 

If the contact has opted out of electronic marketing communications, enable this 
flag. Contacts with this flag enabled can be excluded from Contact Lists. 

Miscellaneous 

Sales Person If there is a designated salesperson associated to this debtor/creditor, enter 
his/her name here. 

Advert/ Source The name of the advertising source through which you received this Contact. 
Select the advert or source if applicable. If one is not available in the list, click the 
Setup button to create one. This opens the Setup Advert Types window; click New 
to create a new Referral item, then save and exit. 
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MSDN 
Yahoo 
Skype ID 

If this Contact has account details for these online networks, enter them here. 

Facebook 
LinkedIn 
Twitter 

To view social media account information for the Contact (see page 147), enter 
their usernames or logon IDs here. 

Note: The LinkedIn ID must be the numerical ID, not a username. The Facebook ID 
can be a numerical ID or a Facebook username, if one has been set up. 

3. Click Save. A number of additional tabs now appear in the window. Enter Contact information in 
these tabs. 

• Marketing tab (see page 123). Assign the Contact to your marketing classes (see page 123), 
or categories, so your marketing campaigns are more targeted to relevant Contacts. 
Additional Marketing Classes can be setup, when this tab is active a Setup Marketing 
Classes button activates. Click this to configure additional or edit existing marketing classes. 

• Invoices tab (see page 123). Lists invoices for which the Contact was the default Contact of 
the Debtor account. 

• Orders tab (see page 124). List any Sales/Purchase Orders associated with the Contact. 

• Notes tab (see page 137).  Enter any notes for the Contact. Use the New Note icon on the 
toolbar to enter a note - this will automatically assign a header to this note. 

• History Notes tab (see page 137). Enter any history notes for the Contact. History notes are 
notes for which the date and subject are also recorded. As with notes, click the New 
History Note icon to create a new history note. 

• Docs tab (see page 140). Link any documents to the Contact. 

• Accounts tab (see page 124). Edit the Debtor/Creditor accounts that the Contact is 
associated with. For example, a Contact may be the manager of one company, the partner 
of a manager of another company, the father of a son who works at another company, and 
so on. 

• Relationships tab (see page 141). Lists any other relevant Contacts the Contact has. 

• Activities tab (see page 144). Lists any tasks and appointments associated with the 
Contact. 

• Opportunities tab. This tab is only displayed when functions from the EXO Business CRM 
module have been added to the EXO Business core. It lists all Opportunities associated with 
the Contact. 

• Social tab. This tab displays information about the Contact from various social media 
services (see page 147). 

4. Click Save. 

5. To make this new Contact the default Contact for this debtor account, click on the Set to Default 
Contact icon in the toolbar. 

Once you have set up the debtor Contact, you can also: 

• Create a relationship between Contacts. 

• Create activities for the Contact (see page 144). 

• Synchronise Contacts with Microsoft Outlook. 

Note: If the Contact’s address details are the same as those on the debtors account, click the Copy 
from Account button and the details are copied here. 
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Contact Marketing Classes 

On the Marketing tab, you can assign the Contact to your marketing classes (see page 123), or categories, 
so your marketing campaigns are more targeted to relevant contacts. 

 
Check the checkboxes for the marketing classes that you need to associate to this contact. 

Setting up Marketing Classes 
To create additional classes or edit existing ones, click the Setup Marketing Classes toolbar button. 

 
Clicking the New button will create a marketing class for the next one in the sequence. If there are a few 
blank classes after last defined class it is recommended editing these as preference. To edit an existing or 
blank class, double click on the entry in the list or highlight and click the Edit button on the toolbar. 

Contact Invoices 

This tab lists invoices for which the contact was the default contact of the Debtor/Creditor account. 
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Contacts Orders 

This tab lists the orders associated with the Contact. 

Note: For this feature to work, the Add debtor contact details to transactions Company-level profile 
setting has to be enabled in EXO Business Config. A salesperson can be associated with Sales Orders 
(see page 356). 

Contact Accounts 

This tab displays the Debtor/Creditor accounts that the Contact is associated with. For example, a Contact 
may be the manager of one company, the partner of a manager of another company, the father of a son 
who works at another company, and so on. 

 
With this tab active in the Contacts window, the following toolbar appears: 

 
1. Assign the Contact to a Debtor or a Creditor. 

2. Set as the default Contact for this debtor. 

3. Un-assign the Contact from this account. 

Emailing Contacts 

Account > Contacts 

You can send emails to individual Contacts, groups of Contacts, or all Contacts, from the Contacts window. 

To email Contacts: 

1. Go to the Account menu and choose Contacts. The Contacts window is displayed. 

2. Select the Contacts you want to email in one of the following ways: 

• Highlight a single Contact 

• Holding the CTRL key down, click on a selection of Contacts 

• Select a marketing class, click Search, select all in that marketing class using the keystroke 
CTRL + A 

• Select all Contacts using the keystroke CTRL + A 

3. Click the Send Email to List toolbar button (  ).   
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4. If you don’t have email addresses recorded for all of the selected Contacts, a warning is displayed, 
and you are prompted to confirm if you want to email the remaining Contacts that do have email 
addresses. Click Yes. 

5. A dialog is displayed asking if you want to hide the CC list in the email. If you don’t want each 
Contact to see the other Contact email addresses being emailed, click Yes to hide the email address 
list. 

Common Account Functions 

Viewing the Transaction History of an Account 

Account > Creditors/Debtors > {double Click the account name} > (Transactions) 

You can easily and quickly view the transaction history of an account in MYOB EXO Business on the 
Transactions tab of the account. From this window, you can also perform a range of tasks, including: 

• creating a new invoice 

• creating a new credit note 

• creating a new payment 

• allocating transactions for the account 

• issuing credit notes 

• searching for an invoice number 

• emailing Debtor invoices and statements 

Note: Although the Transactions tabs for Debtor and Creditor accounts differ slightly, the majority of 
the content is common. 

The transaction history of a Creditor/Debtor is period-based, typically (but not always) monthly periods. 

To view the transactions of a Creditor/Debtor: 

1. From the Creditor/Debtor Account Details (search) window, select the creditor/debtor by double-
clicking the required account’s name. 

2. Click the Transactions tab on the Creditor/Debtor Account Details window. 

The Transactions tab is displayed: 

 

125 



MYOB EXO Business User Guide 

Field Descriptions 
The grid header fields are detailed in the table below: 

Field Description 

Trans # The unique transaction ID. 

Date The date the transaction was created. 

Pd stat seq The unique period number for the period, also identifying the period as Creditors, 
Debtors, GL or Stock. 

Age The period number of the transaction (where for example if 0 is the current month 
of July, ‘1’ is June, ‘2’ is May, and so on). 

Transaction The transaction type, such as Invoice or Payment. 

InvNo The invoice number. 

Ref 1 An internally set reference text/number that varies according to the kind of 
transaction. For example, if a sales order, the sales order number is displayed; if a 
payment, the payment type is displayed. 

Ref 2 An internally set reference text/number that varies according to the kind of 
transaction. For example customer reference number if invoice, or cheque number 
if Ref 1 is Cheque. 

Ref 3 An internally set reference text/number that varies according to the kind of 
transaction. For example, if cheque payment type, then the bank name is displayed; 
if invoice, then ‘invoice’ is displayed. 

Branch Code The branch code of the transaction, such as SYD or AKL. 

Due Date The due date of the invoice, based on the credit terms of the creditor account. 

Amount The total amount of the invoice. 

Outstanding The outstanding amount of the invoice. 

Status The allocation status of the invoice, for example, Unallocated, Partly Allocated, 
Allocated. 

Branch Account If this is a branch account, this is the branch account number. If not, this column 
will display ‘-1’. 

GLBatchNo The GL batch number if this was posted to GL as part of a GL batch. 

Exchrate If multiple currencies are being used, the exchange rate used for this transaction. 
The local currency is ‘1’; otherwise the actual exchange rate used displays as a 
decimal, e.g. ‘0.83’. 
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Debtor transactions only 

Gateway TrxID Each transaction processed by the gateway service provider is issued a reference 
known as a TrxID. This is typically a long alphanumeric code. See the whitepaper on 
payment gateways. 

Batch No This is the batch number of the banking batch. 

Gateway No The is the number of the defined gateway for this transaction. 

? Right-click on the transaction line and choose Toggle Query Status to put a 
question mark on the transaction, to reflect that the transaction is in question. This 
can then be reported on. 

Creditor transactions only 

Auth The authorisation status of the invoice 

Paystatus The payment status of this invoice, for example, Released, paid. 

Menu Commands 

 

 

Debtor and Creditor Debtor Specific 

1. New Invoice: Create a new Creditor invoice (see page 325) or Debtor invoice (see page 384). 

2. New Payment: Enter a Payment on a Creditor invoice (see page 330) or receive a Debtor payment 
(see page 398). 

3. Allocate transactions for this account: Enter a payment on a Creditor invoice (see page 330) or 
allocate a Debtor receipt to an invoice (see page 389). 

4. Issue a Credit Note: Enter a credit note for a Creditor (see page 338) or create a credit note for a 
Debtor (see page 412). 

5. Invoice Number search: Search for an invoice (see page 131). 

6. Refresh: Provides an updated transaction list. 

7. Automatically allocate payments to the oldest invoice: (Debtors only). This will also allocate 
credits (negative value invoices) and refunds (negative payments) and zero value transactions. 

8. Email Invoice: Click this button to email the selected invoice to the Debtor as a PDF attachment. 

9. Email Statement: Click this button to email a statement to the Debtor as a PDF attachment. 
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Shortcut Menu 
Right clicking on any invoice summary line opens the following shortcut window. The table below this 
diagram details the actions of the shortcut commands. 

 

 

Creditor shortcut menu Debtor shortcut menu 

        

Shortcut Command Description 

View Invoice View the invoice in a report format. 

Print Invoice Reprints the Debtor invoice (see page 391). 

Print Receipt Prints a payment receipt. Only available for a payment transaction. 

Edit Invoice Opens the invoice to edit its details. This option is only available if the 
Permitted level of access to debtor transaction editing or Permitted 
level of access to creditor transaction editing User-level profile 
setting is set to “Full invoice editing allowed”. 

Edit Ref Fields Edit the transaction reference fields for the invoice (see page 389). 
This option is only available if the Permitted level of access to debtor 
transaction editing or Permitted level of access to creditor 
transaction editing User-level profile setting is set to “Full invoice 
editing allowed” or “Invoice header fields editing allowed”. 

Duplicate Invoice Select to create a duplicate of a Debtor invoice (see page 388). 

Generate Credit Provides a copy of the negative invoice. 
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Reverse Payment Reverses a Debtor payment (see page 404). 

Journal Opens the Debtors Adjustment Entry window to make a Debtors 
journal adjustment entry transaction (see page 413). 

Margin Pie Chart Displays a graph for the invoice showing margins. 

View Allocation Info Displays a list with the allocation information in a separate window. 

Reverse Allocation Reverse all allocations associated with this transaction (payment or 
invoice). This option is only available if the Allow reversal of 
debtor/creditor allocations User-level profile setting is enabled. This 
option is not available for transactions with deposits or foreign 
currencies. 

Refresh Updates the entire transaction list. 

Authorise this Transaction Where M-Powered Payments are used (see page 334), this option 
authorises the selected transaction. 

View Reconciliation Info Provides a list with the reconciliation information. 

View Purchase Order 
Invoice History 

Displays the Purchase Order History window. 

Allocate To Oldest Allocates a payment transaction to the oldest outstanding invoice. 

Toggle Query Status (?) Puts a question mark on the transaction, to reflect that the 
transaction is in question. This can then be reported on. You may need 
to add the ? column by right-clicking on the column header and 
selecting Select visible columns. 

View Banking Batch Opens the Debtors Banking Batches window (see page 409). 

View GL Batch Transactions Opens the GL Batch Transactions window (see page 280), showing all 
GL transactions associated with this transaction. This option is only 
available for transactions that have been posted to the GL, and 
requires the Allow Sub ledgers drill through to GL Transactions User-
level profile setting to be enabled. 

View Job Where the Job Costing add-on module is used, displays the job 
associated with the transaction. 

View Sales Order History Displays the Sales Order History window (see page 363). 

View Analysis Codes Displays the Analysis Codes (see page 82) associated with the 
transaction. 

Preview Journals Displays the GL Batch Transactions window (see page 280), showing 
the Debtor Ledger and Stock Ledger transactions that will be 
generated for the transaction. This is a preview only - no transactions 
are saved when the window is closed. 
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Search Options 

Group by Period 

Checking the Group by Period checkbox groups the transactions by period: 

 
Clicking on a period line lists all the transactions for that period in the grid in the area below the period 
groups. Once the group has been selected it can be minimised by clicking the minimise icon (  ). 
Maximise this view by clicking the icon again. Minimising this view provides a greater display area for the 
group’s individual transactions in the grid below. 

The transactions by Period grid has its own grid fields (see page 10), which are defined in the table below: 

Shortcut 
Command 

Description 

Age In MYOB EXO Business, transaction ages (see page 131) are numbered from 
current (0) backwards. See for details on this numbering system. 

Period Name This is the period name that correlates to the 

Invoices This is a total for all invoices submitted over this period. 

Credits This is the total for the credits issued to this debtor over this period. 

Payments This is the total for all types of payments received from the debtor for this 
period. 

Refunds This is the total for all refunds issued to the debtor for this period. 

Dr Adjustments This is the total for all debtor adjustment transactions (see page 413) for the 
selected period. 

Cr adjustments This is the total for all creditor adjustment transactions for the selected period. 
Creditor adjustments are similar to Creditors Payment Entry, this function 
creates adjustment entries against a creditor account, with predefined reasons 
for the adjustment. 

Balance The current debtor account balance for the selected period. 

130 



Working with Accounts 

Show Only Unallocated 

Checking the Show only unallocated checkbox filters the transaction list to display only the transactions 
that are not allocated to an account. This is useful when it is necessary to allocate transactions that have 
not been previously allocated. 

Transaction Page Numbering 
While MYOB EXO Business stores transaction dates, it is not a purely date-based system. It does not rely on 
dates for critical procedures such as transaction ageing and posting between ledgers, nor are dates used by 
any of the standard reports within EXO Business to calculate control totals. 

MYOB EXO Business employs a method of tagging all transactions with a nominated period number at the 
time of posting. As an extra validation, EXO Business can ensure that the transaction date given is valid for 
the period that the transaction is being posted to. This method is used to avoid the traditional problems 
associated with incorrectly entered dates and extra processing overhead required to ‘age’ transactions into 
periods which often makes purely date based solutions very limited in scale. 

In MYOB EXO Business, transaction ages are numbered from current (0) backwards. This may be different 
from the system you are familiar with, however it does give you some useful logic consistency. 

Example: 

0 = current period 

1 = One period ago (last month) 

2 = Two periods ago 

54 = Fifty-four periods ago etc. 

MYOB EXO Business knows which period in the period table is the current one, and uses this as a point of 
reference to display the name of the period on reports and within data entry screens. 
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Invoice Number Search 

Creditor/Debtor account > Transactions tab >  

Clicking the Invoice Search button on the Transactions tab (  ) or pressing F7 opens the Invoice Search 
window. 

The Invoice Search window has a right click menu to giving access to many other windows. This includes 
‘drilling’ to the Account (Debtors or Creditors) where further transactions, reversals or updating of header 
reference fields may be performed from the transactions tab (if you have sufficient access rights within 
those windows). 

 
From  here you can reprint invoices, credits and receipts. Set search criteria and click Search. The Print 
buttons are not enabled until you have selected a search item. 

The filters to search by Shift and Terminal ID are disabled when the window is set to Creditors mode as they 
are not applicable. 

Field Definitions 
The grid (see page 10) header fields are detailed in the table below: 

Field Description 

Seqno A unique identifier for records in tables. 

Entry Time The time of the invoice entry. 

Inv Date The date of the invoice entry. 

A/c The account number. 

InvNo The invoice number. 

Trans type The transaction type, i.e. Invoice or credit note etc. 
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Name The company name of the debtor or creditor. 

OutStanding Any outstanding amounts for this invoice are listed here. 

Tot inc GST The total amount that was invoiced, including GST. 

Tot exc GST The total amount that was invoiced, excluding GST. 

Taxtotal The total amount that was taxed to this invoice. 

Alpha Code This is the debtor/creditor code which is normally automatically assigned by 
the system. Generally this is the first 6 characters of the account name 
followed by two sequential numerals, starting at 01. 

Session_id A session id is an integer value (number) which tags all transactions at the 
time of saving. It’s transaction scoped, so when you create an invoice which 
has invoice line and optional payments, all those transactions get grouped 
together with the same session id. 

It’s a grouping type of field, i.e. this field gets moved / copied when the source 
transaction moves through the system. The invoice lines will receive a 
session_id  when saved. The invoice lines required the stock to be 
decremented, resulting in the creation of a stock transaction, this copies the 
invoice line session id and then the stock and invoices are posted to the GL. 
This creates a GL transaction and once again the invoice line session id gets 
copied.  It’s primarily used to ensure that once a source transaction is posted 
to the GL all its source transactions can be easily identified. 

Gatewayno This configures EFTPOS / Credit card payment gateway numbers. In MYOB 
EXO Business you can set up Credit card payment gateways . Like a direct 
payment service, a web service for the management and handling of 
payments. As EXO Business can handle multiple payments, it tags the 
payment debtors lines with the seqno identifying the gateway used. 

Eftauth This usually contains EFTPOS / Credit Card authorisation / approval  codes 
related to payment gateways. 

Eftcaid This usually contains a unique EFTPOS computer / terminal id . See POS / 
EFTPOS whitepaper. 

Eftstan This usually contains a unique EFTPOS / Credit Card  transactional id. See POS 
/ EFTPOS whitepaper 

Job# Usually a jobcost jobno / jobcode if an invoice came as a result of an EXO Job 
Costing job. 
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Toolbar 

 

Print Invoice Print Docket 

  

 

View Invoice 
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Recording Additional Information through Extra Fields 

If you have any specific information on an account or stock item that cannot be displayed elsewhere, you 
can set up extra fields (see page 23) to display on the account’s Extra Fields tab. 

Note: This tab is available only if you have set up extra fields and displays the fields that you have 
established. 

Debtor and Creditor accounts support 24 extra fields; the first three extra fields are displayed in the 
Details1 tab of the Debtor/Creditor account, and the remainder on the Extra Fields tab. For Stock items, all 
extra fields are displayed on the Extra Fields tab. 

To record extra field details: 

1. Click the Extra Fields tab. 

 
2. Complete any necessary fields on this tab. 

Debtor/Creditor Account Serial Numbers 

Account > Debtors/Creditors > {Double Click the Account name} > (Serials) 

The Serials tab on Debtor and Creditor accounts is used to record all serialised stock items (see page 199) 
sold to the Debtor/Creditor. This enables you to quickly handle Debtor enquiries about stock items they 
have purchased, for warranty, and return policy purposes. 

Note: Before serial numbers can be used, they must be activated for the database by setting the 
profile Serial Numbers Tracking Enabled. Serial numbers may only be used with stocked items. 
Lookup items cannot be serialised. 

Serial Number Types (Modes) 
Occurrence of serial number processing depends on both the serial type (mode) of the stock item, and the 
class of the trading partner in the particular MYOB EXO Business function. 

There are three classes of trading partners: 

• Creditor (Supplier) – e.g. functions like purchase orders and creditor invoices. 

• Internal (no Creditor or Debtor) – e.g. adjustments, transfers and works orders. 

• Debtors (Customer) – e.g. sales orders and debtor invoices. 

You can search for a serial number across all branches: 

1. Click on the Serials tab of the debtor/creditor account. 

2. Enter the serial number you are searching for, or leave blank to view all serialised stock items sold 
to this debtor. 

3. Check the Exclude not in stock checkbox to exclude. 

4. Check the Exclude pre-assigned checkbox. 
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Search Filters 

Option Description 

Serial Number Serial numbers are maintained as part of the workflow whenever stock 
transactions are created for a serialised stock item.  This is usually associated 
with a business document (e.g. Debtor invoice).  When the document is saved 
using the Save & Exit or Save buttons, the stock items that should be 
serialised are determined based on the combination of the document class 
and the serial type of the stock items.  The quantity of serials for each of these 
is computed. 

Location Choose the location from the list to filter this search. 

Exclude not in stock Tick this to filter out serial number results in the search that are not in stock. 

Exclude preassigned Tick this to filter out serial number results in the search that have been pre-
assigned. 

Serialised Item Details 
The grid (see page 10) header fields are detailed in the table below: 

Column Description 

Stock Code The Stock item code. 

Description The description of the stock item. 

Serial No The serial number of the stock item. 

Location The location from which the serialized stock item was purchased. 

Assigned Document If no documents are assigned the default will be none. If there are there will 
be a link to this document. 

CR Accno The creditor account number 

Reference If applicable a reference number will be listed here. 

BOM Code Bill of materials code 

Worksorder No The works order number. This number is allocated by the system. 

RequestSeqno Joins stock requests 

Job No The job number. 

InStock Provide indication if this serial number available for sale. 

Last Updated The date that the details on this stock item where last updated. 
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Recording Notes 

Notes are a freeform way of recording any communication or general information related to a selected 
account master. Notes can be added to Debtor, Creditor, Stock and General Ledger accounts. The 
username and current date are automatically entered at the start of a new note. Notes are displayed in a 
list you can scroll through. 

To record notes for an account: 

1. Go to the Notes tab on the Account Details window: 

 

2. Click the New Note button (  ) to enter a new note. The current system date is automatically 
inserted with the note. 

3. Right click anywhere in the editing area to open a popup menu. Most of these are standard editing 
commands with the addition of Insert Username, to insert your name at the end of the note and 
Insert Common Phrase, see the tip below. 

4. After entering the contents of the note, click the Save button to save the note entry. 

Tip: Use the Common Phrases utility (see page 139) when entering repetitive information, or to save 
typing and assist with retaining a generic format to notes. 

History Notes 

History notes are more structured and formal than Notes (see page 137). You can search for history notes, 
delete them, and email them. Generally use history notes for more formal communications with the 
debtor/creditor, that you want to keep a record of. 

 A History Notes tab is available on the Debtors, Creditors, Non Accounts, Stock and General Ledger 
accounts windows. The following table describes the available buttons and fields on this tab: 

Field/Button Description 

New History Item button Used to create a new history item. This opens the New or Edit window. 

Delete History Item button Used to delete an existing history item. 

Source What sort of account the history note was created from. 
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Date The date this history item was created. Defaults to the current date but 
can be changed. 

Subject The subject of the history note. 

Staff The staff member who is creating this note. Defaults to the currently 
logged in user, but you can enter another staff member in this field, or 
use the question mark search facility to search for another staff 
member. 

History Notes Window Fields 

To create a new history note, click the New History Item button (  ) on the account window toolbar. 

 
The following table describes the fields in the History Notes window: 

Field Description 

Date The date this history note was created. Defaults to the current date but can 
be changed. 

Staff The staff member who is creating this note. Defaults to the currently logged 
in user, but you can enter another staff member in this field, or use the 
question mark search facility to search for another staff member. 

Subject Enter the subject of the history note. 

(Body) Enter the content of the history note into the main text entry field on this 
window. 

Email this History Item Use this button to email this history note (see page 139). 
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Editing the History Note 

1. From the History Notes tab, click New History Note (  ) to enter a new note. The current system 
date is automatically inserted into the note. This date can be changed from the drop-down list. 

2. Right-click anywhere in the editing area to open a popup menu. Most of these are standard editing 
commands with the addition of Insert Username, to insert your name at the end of the note and 
Insert Common Phrase, see the tip below. There is also Spell Check feature for history notes. 

Note: If the Spell Check option is not available, you may need to install the spellchecker DLL files 
and register them manually. Contact Support for the required files and instructions on how to 
install them. 

3. After entering the contents of the note, click Save to save the note entry. 

TIP: For entering to repetitive information and to save typing and assist with retaining a generic 
format to notes, use the Common Phrases utility (see page 139). 

Saving and/or Emailing this History Note Item 
1. Review the history note, make any changes if required, and then click Save. This is then recorded in 

the History Notes tab. Only after saving the note will the Print and Email this history item buttons 
become available. If you choose to Email this note, an email is automatically created with the 
following pre-populated information: 

• By default the addressee of the email is the current Debtor/Creditor, using the email 
address recorded on the Details 1 tab. 

• The subject of the email is the Subject of the history note. 

• The content of the email is the body of the history note. 

2. If necessary, make any changes to the email and send. 

Common Phrases 

A library of common phrases can be built to save typing and assist with retaining a generic format to notes. 

To select or create a common phrase: 

In a supported field, press CTRL + ‘ (single quote). The Common Phrases window appears: 

 
To add a phrase, type the phrase and click the Add Phrase button. 
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To select a common phrase to the text box, begin typing the phrase and the cursor will focus on the nearest 
match in the search grid. Either click OK to select the highlighted phrase, or double-click the phrase 
required. 

To delete a phrase from the list, highlight the phrase to be deleted and click the Del. Phrase button. 

Managing / Creating Documents 

The Documents tab lists all the documents related to an Opportunity or a Debtor, Creditor or Stock 
account. The Document Manager, which adds, edits and removes documents from accounts, its standard 
functionality throughout MYOB EXO Business, such as in the GL, Creditors and Stock modules. 

It may be useful for your business to maintain copies of documents that you send each Creditor/Debtor. 

Any file that is recognized by Windows, including spreadsheets, documents, and graphics, can be attached 
to the account. Any email sent from MYOB EXO Business is automatically attached to the relevant account. 
You can either store documents as attachments, or in the EXO Business database. You can export a 
document stored in the EXO Business database back to a standalone file. 

The template is a fixed format, once imported, the document is stored inside the database. It is backed up 
when you back up your database. If you import many large documents, the size of your database is 
substantially increased. 

Note: If you transport the database frequently, the use of this feature should be minimal. It is 
recommended that you do not store large documents here. 

To create documents for the Creditor, click the Documents tab in the account masters window. 

Field Definitions 
The grid header fields are detailed in the table below: 

Field Description 

Doc. Date The date the document was attached to the account. 

Reference Any internal reference text for the document. 

Doc. Code Any internal document code for the document. 

Description A description of the attachment, entered by the person who attached the file. 

File Name The filename of the attached file. 

Linked Whether or not the attached file is stored in the MYOB EXO Business database, or 
linked to EXO Business but stored separately on your computer or network. 
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Menu Commands 
All the commands for document management are from the toolbar, detailed below: 

 
1. Run Document Manager to add, edit and delete documents. Launches the Document Manager (see 

page 525). 

2. Create and edit an RTF merge letter. (see page 531) Create a merge letter to this Debtor/Creditor 
using one of your preset Clarity letter templates. 

3. Delete the selected document. Delete the attached file highlighted in the grid. 

4. Merge account data against a template (see page 532) to produce form letter. 

5. Export a document to another location (see page 526). 

6. Import an existing document into this page (see page 526). 

Relationships 

Relationships can be formed between Contacts, Debtors, Creditors and Non Accounts. New relationship 
types can be defined to link any of the entities of Debtors, Creditors, Non Accounts, Contacts, and staff. 

Creating New Relationship Types 
Some relationship types will have been predefined for you; however you are likely to want to create 
relationship types of your own. To do this, right click on any area of the relationship tree and select Setup 
Relationships. 

The Setup Relationships window opens: 
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Double-click on an existing relationship type to edit it, or click New to define a new type. 

 
Note: Except for the Image, you cannot edit the details for a relationship type that is already in use.   

A relationship in EXO Business is a two-way relationship between two entities in the EXO Business system. 
For example, a relationship type may define the relationship between Contacts and the suppliers 
(Creditors) they work for. When viewing a Contact record and creating a relationship between it and a 
Creditor, this relationship type could be called “Works for”; when viewing a Creditor’s record and creating 
relationships between it and Contacts, the same relationship type could be called “Employs”. 

Field Description 

Entity Source  Select the first type of entity that the relationship type applies to. Choose from: 

• Contact 

• Customer (i.e. Debtor) 

• Supplier (i.e. Creditor) 

• Non Account 

• Staff 

For example, if the relation type defines the relationship between a Contact and 
a Creditor, select “Contact” here. 

Entity Destination Select the second type of entity that the relationship type applies to. For 
example, if the relation type defines the relationship between a Contact and a 
Creditor, select “Creditor” here. 
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Rel. Name Enter a name for this relationship type when viewed from Source to Destination. 
For example, if the relation type defines the relationship between a Contact and 
the Creditor that they work for, you could enter “Works for” here. 

Inverse Rel. Name Enter a name for this relationship type when viewed from Destination to Source. 
For example, if the relation type defines the relationship between a Contact and 
the Creditor that they work for, you could enter “Employs” here. 

Category Read-only field that displays the category that the relationship is grouped under. 
Displays “User Defined” for relationship types that are added manually. 

Image Select an icon image to appear next to relationships of this type on the 
Relationships tab, or click Default Image to use the default. 

Creating Relationships between Entities 
To create a relationship between EXO Business entities: 

1. Go to the Relationships tab of the Debtors, Creditors, Non Accounts or Contacts window. 

2. Right-click anywhere in the main window and choose New. The Relationship : New window is 
displayed: 

 
3. Select the relationship type (see page 141) in the Relationship Name field. 

4. Click the ellipsis button of the second Entity Name field, and search for and select the “target” 
entity. 

5. Click OK. 

Removing Relationships 
To remove a relationship, right click on the relationship icon and select Remove. 

143 



MYOB EXO Business User Guide 

Activities 

Activities can be set up in EXO Business to provide reminders and progress indicators for important 
events.  An activity can be a Task or an Appointment: 

• A Task is a to-do item that must be completed in a specified time frame. 

• An Appointment is an event scheduled for a specific time. 

Activities can be accessed in multiple ways: 

• Via the Activities tabs in the maintenance screens for Contacts, Debtors, Creditors and Non 
Accounts. 

• Via the Activity Search widget, which can be added to the EXO Business business flow menu. 

• Via the EXO Business CRM module. 

When using the EXO Business CRM module, activities can be synchronised with Microsoft Outlook. Tasks 
are converted to Outlook Tasks and Appointments are converted to Outlook Appointments. 

Creating an Activity 
Click the New Activity (  ) toolbar button to create a new activity. Alternatively, right-click on the Activity 
Search widget’s calendar in the time slot that you want to create the activity in. 

The Activity Window 

 
Note: If Extra Fields (see page 23) have been set up for Activities, an Extra Fields tab will also be 
available on this window. 

This is the window for entering new activities; use the table below as a reference for completing the fields 
in this window. 
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Field Description 

Activity Type Select whether the activity is a Task or an Appointment. 

Type This is a user-definable classification for the activity. Select a type from the list, or 
select “Edit List...” to create a new type. 

Sync with 
Outlook 

If this box is ticked, the activity will be synchronised with Outlook whenever a sync is 
performed. If this box is not ticked, the activity will not be included in 
synchronisation operations. 

Subject Type a brief description of the activity and its purpose. 

Company 
Contact 

Assignment of an activity to a Company and/or Contact is optional. Where assigned, 
the activity will appear on the Activities tab of that company (Debtor, Creditor, Non 
Account) and/or the Contact screen. 

Note: When entering the Company name, use the search option by typing ? 
and pressing TAB. 

Opportunity This field is only available when the EXO Business CRM module is licensed. If the 
activity was created from an Opportunity, that Opportunity will be displayed here; 
otherwise, you can optionally specify an Opportunity to associate the activity with. 

Job Code This field is only available when the EXO Job Costing module is licensed. If the activity 
was created from a job, that job will be displayed here; otherwise, you can optionally 
specify a job to associate the activity with. 

Campaign 
Wave 

If the EXO Business CRM module is installed, activities can be associated with a 
campaign wave. 

Note: When creating an activity from the Details tab of the Campaigns 
window, the activity is associated with the first wave of that campaign. When 
creating an activity from the Waves tab, the activity is associated with the 
selected campaign wave. 

Label A label can be specified for the activity - this affects how it will appear on calendar 
displays. 

Priority A priority (Low, Normal or High) can be specified for the activity. Low and High 
priority tasks are indicated with an icon on calendar displays. 

Status The Status setting has predefined list entries, but these may be edited or added to 
using the “Edit List...” option. 

For Tasks, clicking the Mark Complete toolbar button automatically updates this 
property to “Completed”. 

Assigned To 
Assigned By 

The EXO Business Staff members that the activity was assigned to and by. 
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% Complete This property applies to Tasks only. Specify the percentage completion by entering a 
number or using the arrow controls. 

Clicking the Mark Complete toolbar button automatically updates this property to 
100%. 

Start Time 
End Time 

The start and end time for the activity. 

All day event If this is selected, the selections for the time of day will disappear as they are no 
longer valid. 

Reminder If you tick this checkbox, the system will pop up a reminder from the system tray 
after adding a reminder icon. Reminders can be enabled or disabled using the Enable 
Reminders option on the Tools menu of the Activity Search window/Dashboard 
widget. 

Show time as This property applies to Appointments only. Select how to display the time for this 
activity on the Task Scheduler. Choose from: 

• Free 

• Tentative 

• Busy 

• Out of Office 

Note: The relationship between the Status and % Complete properties is automatically maintained. 
For example, setting Status to “Completed” automatically updates the % Complete value to “100” 
and vice versa. 

Once all properties are configured, click Save & Exit on the toolbar to save your changes and close the 
Activity window, or Save & New to save changes to this Activity and reset all fields so that a new Activity 
can be added. 

Activity Recurrence 
Click the Recurrence button to set an activity as recurring and establish the frequency. 
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